Working with a text in the AutoCAD program

Guidance for laboratory works for “Informatics and computer modeling basics” course /for foreign students of 2nd year studying by orientation 6.060102 «Architecture»/

Укладачі:  Б. П. Бочаров,
           І. Л. Яковицький,
           М. Ю Воєводіна,
           Ю.В. Левіков.

Рецензент:  канд.фіз-матем.наук А.Б. Костенко

Рекомендовано кафедрою Прикладної математики і Інформаційних технологій,  
протокол № 6 від 24 січня 2009 р.
Theme: Working with a text in the AutoCAD program

Purpose: acquiring skills of a text input and editing

Work order:

1. Open the drawing *tsk2.dwg*.
2. Create a new layer.
3. Using the TEXT command, write a short autobiography (you must use the command TEXT options Start point, Align, Fit, Center, Mid point).
4. Create a new layer.
5. Copy the text created in p. 3 into a free place.
6. Transfer the text into the new layer (using the CHANGE command).
7. Mirror the text (using the MIRROR command) in relation to a line lying to the left of the text (allow AutoCAD to change the text orientation).
8. Mirror the source text in relation to a line lying to the right of text (do not allow AutoCAD to change the text orientation).
9. Mirror the text (the MIRROR command) in relation to a line lying below the text (allow AutoCAD to change the text orientation).
10. Mirror the source text in relation to a line lying above the text (deny AutoCAD changing the text orientation).
11. Create a new layer.
12. Draw a none-zero width closed polyline consisting of 5 straight lines and 5 arc segments.
13. Use the BREAK command in each of the segments to «place windows», that is, to delete a part of every segment.
14. Save the drawing in the personal folder and compress it (Zip).
15. Save this archive in the Academy distance learning system.
Overview of Creating Text

The text you add to your drawings conveys a variety of information. It may be a complex specification, title block information, a label, or even part of the drawing.

Single-Line Text
For short entries that do not require multiple fonts or lines, create single-line text. Single-line text is most convenient for labels.

Multiline Text
For long, complex entries, create multiline, or paragraph text. Multiline text consists of any number of text lines or paragraphs that fit within a width you specify; it can extend vertically to an indefinite length.

Regardless of the number of lines, each set of paragraphs created in a single editing session forms a single object, which you can move, rotate, erase, copy, mirror, or scale.

There are more editing options for multiline text than there are for single-line text. For example, you can apply underlining, fonts, color, and text height changes to individual characters, words, or phrases within a paragraph.

Annotative Text
Use annotative text for notes and labels in your drawing. You create annotative text by using an annotative text style, which sets the height of the text on the paper.

For more information about creating and working with an annotative text, see Create Annotative Text.

Create Single-Line Text

You can use single-line text to create one or more lines of text, where each text line is an independent object that you can relocate, reformat, or otherwise modify.

Use single-line text (TEXT) to create one or more lines of text, ending each line when you press ENTER. Each text line is an independent object that you can relocate, reformat, or otherwise modify.
When you create single-line text, you assign a text style and set alignment. The text style sets the default characteristics of the text object. The alignment determines what part of the text character aligns with the insertion point. Use the TEXT command to enter the text in-place, or enter -text on the command line to enter the text on the command line.

You can insert a field in single-line text. A field is text that is set up to display data that might change. When the field is updated, the latest value of the field is displayed.

The text styles used for single-line text are the same as those used for multiline text. When you create text, you assign an existing style by entering its name at the Style prompt. If you need to apply formatting to individual words and characters, use multiline text instead of single-line text.

You can also compress single-line text to fit between points that you specify. This option stretches or squeezes the text to fill the designated space.

The DTEXTED system variable specifies the user interface displayed for editing single-line text.

**Align Single-Line Text**

As you create text, you can align it. That is, you can justify it with one of the alignment options shown in the following illustrations. Left alignment is the default. To left-align text, do not enter an option at the Justify prompt.
The TEXT command creates a single-line text object.

Menu: Draw ➤ Text ➤ Single Line Text

Command entry: text

It displays a simplified version of the In-Place Text Editor that consists of a bounding box that is the height of the text and expands as you type. Right-click to select options on the shortcut menu.

If TEXT was the last command entered, pressing ENTER at the Specify Start Point of Text prompt skips the prompts for paper height and rotation angle. The text that you enter in the In-Place Text Editor for single-line text is placed directly beneath the previous line of text. The point that you specified at the prompt is also stored as the insertion point of the text.

If the DTEXTED system variable is set to 1, text created using TEXT or DTEXT displays the Edit Text dialog box.

If DTEXTED is set to 2, the In-Place Text Editor is displayed. When creating text, you can click anywhere in a drawing to create a new text block. You can also use the keyboard to move among text blocks (for example: for new text created using the TEXT command, you can navigate through text groups by pressing TAB or Shift+TAB, or edit a group of text lines by pressing ALT and clicking each text object.)

*Note.* Text that would otherwise be difficult to read (if it is very small, very large, or is rotated) is displayed at a legible size and is oriented horizontally so that you can
easily read and edit it.

You can enter special characters and format text by entering Unicode strings and control codes.

Use -TEXT to honor the TEXTEVAL system variable.
DTEXT is the same as TEXT.

Create Multiline Text

You can create one or more paragraphs of multiline text (mtext) in the In-Place Text Editor (or an alternative text editor) or use prompts on the command line. You can also insert text from a file saved in ASCII or RTF format.

Before entering or importing text, you specify opposite corners of a text bounding box that defines the width of the paragraphs in the multiline text object. The length of the multiline text object depends on the amount of text, not the length of the bounding box. You can use grips to move or rotate a multiline text object.

The In-Place Text Editor displays the bounding box with a ruler at the top and the Text Formatting toolbar. The editor is transparent so that, as you create text, you can see whether the text overlaps other objects. To turn off transparency while you work, select Opaque Background on the Options menu. You can also make the background of the finished multiline text object opaque and set its color.

You can also insert fields in multiline text. A field is text that is set up to display data that might change. When the field is updated, the latest value of the field is displayed.

Text Style

Most characteristics of the text are controlled by the text style, which sets the default font and other options, such as line spacing, justification, and color. You can use the current text style or select a new one. The STANDARD text style is the default.

Within the multiline text object, you can override the current text style by applying formatting such as underlining, boldface, and different fonts to individual
characters. You can also create stacked text, such as fractions or geometric tolerances and insert special characters, including Unicode characters, for TrueType fonts.

Note. Not all SHX and TrueType text fonts support Unicode characters.

Text Properties

In the Properties palette, you can view and change the object properties of a multiline text object, including properties that apply specifically to text.

- Justification determines where text is inserted with respect to the bounding box and sets the direction of text flow as text is entered.
- Line space options control the amount of space between lines of text.
- Width defines the width of the bounding box and therefore controls where the text wraps to a new line.
- Background inserts an opaque background so that objects under the text are masked.

Justify Multiline Text

Justification of multiline text objects controls both text alignment and text flow relative to the text insertion point.

There are nine justification settings for multiline text.
Justification controls both text alignment and text flow relative to the text insertion point. Text is left-justified and right-justified with respect to the boundary rectangle that defines the text width. Text flows from the insertion point, which can be at the middle, the top, or the bottom of the resulting text object.

If a single word is longer than the width of the paragraph, the word will extend beyond the paragraph boundary.

**In-Place Text Editor**

The MTEXT command creates paragraphs of text as a single multiline text (mtext) object

**Toolbar:** Draw

**Menu:** Draw ➤ Text ➤ Multiline Text

**Pointing device:** Double-click a multiline text object.

**Command entry:** mtext

**Dashboard:** Text panel, Multiline Text

After you specify the point for the opposite corner, the in-place text editor is displayed.

If you specify one of the other options, or if you enter -mtext at the command prompt, MTEXT bypasses the In-Place Text editor and displays additional command prompts.

In-Place Text Editor Creates or modifies single or multiline text objects. You can import or paste text from other files to use in multiline text, set tabs, adjust paragraph and line spacing and alignment, and create and modify columns.

The In-Place Text Editor includes a Text Formatting Toolbar, a Paragraph Dialog Box, a Columns Menu, and an Display Options Menu. When a table cell is selected for editing, the In-Place Text Editor displays column letters and row numbers.
**Text Formatting Toolbar**

Controls the text style for a multiline text object and character and paragraph formatting for selected text.

*Note.* Text that you paste from other word processing applications such as Microsoft Word will retain most of its formatting. With the options in Paste Special, you can strip out paragraph formatting such as paragraph-based alignment or character formatting from the pasted text.

**Style**

Applies a text style to the multiline text object. The current style is saved in the TEXTSTYLE system variable.

Character formatting for font, height, and bold or italic attributes is overridden if you apply a new style to an existing multiline text object. Stacking, underlining, and color attributes are retained in characters to which a new style is applied.

Styles that have backward or upside-down effects are not applied. If a style defined with a vertical effect is applied to an SHX font, the text is displayed horizontally in the In-Place Text Editor.
Font
Specifies a font for new text or changes the font of selected text. TrueType fonts are listed by font family name. AutoCAD compiled shape (SHX) fonts are listed by the name of the file in which the fonts are stored. Custom fonts and third-party fonts are displayed in the editor with Autodesk-supplied proxy fonts.

A sample drawing (TrueType.dwg) showing each font is provided in the sample directory.

Annotative
Turns Annotative on or off for the current mtext object.

Text Height
Sets the character height in drawing units for new text or changes the height of selected text. If the current text style has no fixed height, the text height is the value stored in the TEXTSIZE system variable. A multiline text object can contain characters of various heights.

Bold
Turns bold formatting on and off for new or selected text. This option is available only for characters using TrueType fonts.

Italic
Turns italic formatting on and off for new or selected text. This option is available only for characters using TrueType fonts.

Underline
Turns underlining on and off for new or selected text.

Overline
Turns overline on and off for new or selected text.

Undo
Undoes actions in the In-Place Text Editor, including changes to either text content or text formatting. You can also use CTRL+Z.

Redo
Redoes actions in the In-Place Text Editor, including changes to either text content or text formatting. You can also use CTRL+Y.
Stack

Creates stacked text, for example, fractions, if the selected text contains stack characters. Also, unstacks text if stacked text is selected. When the stack characters, carat (^), forward slash (/), and pound sign (#), are used, the text to the left of the stack character is stacked on top of the text to the right.

By default, text that contains a carat converts to left-justified tolerance values. Text that contains the forward slash converts to center-justified fractional numbers; the slash is converted to a horizontal bar the length of the longer text string. Text that contains the pound sign converts to a fraction separated by a diagonal bar the height of the two text strings. The characters above the diagonal fraction bar are bottom-right aligned; the characters beneath the diagonal bar are top-left aligned.

Text Color

Specifies a color for new text or changes the color of selected text.

You can assign text the color associated with the layer it is on (BYLAYER) or the color of the block it is contained in (BYBLOCK). You can also select one of the colors in the color list or click Other to open the Select Color dialog box.

Ruler

Displays a ruler at the top of the editor. Drag the arrows at the end of the ruler to change the width of the mtext object. Also displays height and column grips when column mode is active.

You can also select tabs from the ruler. Clicking the Tab Selection button changes tab styles from left, center, right, and decimal. Once you make your selection, you adjust the corresponding tab in the ruler or in the Paragraph dialog box.

OK

Closes the editor and saves any changes that you made.

Options

Displays a list of additional text options. See Additional Text Options.

Columns

Displays the column flyout menu, which provides three column options: No Columns, Static Columns, and Dynamic columns. See Columns menu.
**MText Justification**
Displays the MText Justification menu with nine alignment options available. Top Left is the default.

**Paragraph**
Displays the Paragraph dialog box. See the Paragraph dialog box for a list of the options.

**Left, Center, Right, Justified and Distributed**
Sets the justification and alignment for the left, center, or right text boundaries of the current or selected paragraph. Spaces entered at the end of a line are included and affect the justification of a line.

**Line Spacing**
Displays suggested line spacing options or the Paragraph dialog box. Line spacing is set in the current or selected paragraph.

*Note.* Line spacing is the distance between the bottom of the upper line and the top of the lower line of text in a multiple line paragraph.

The predefined options are:

- **1.0x, 1.5x, 2.0x, or 2.5x** – sets the line spacing at .5x increments in multiline text.
- **More** – displays the Paragraph dialog box, which provides additional options.
- **Clear Paragraph Spacing** – removes line spacing settings from the selected or current paragraph. The paragraph defaults to the mtext space setting.

Additional options in the Paragraph dialog box:

- **Exact** – defines the space with an arbitrary unit value the user specifies. Changing text height will not affect line spacing.
- **Multiple** – Instead of assigning a value to line spacing, you specify spacing according to text height. When text height is not consistent in one line, the line space will be determined by the largest text height value in that line.
- **At least** – takes both the user specified arbitrary value and the text height to determine spacing. If text height is smaller than the arbitrary value the line space is determined by the user specified value. If the text height is larger, the line spacing is equal to the text height value.
Note. Not all of the new options for paragraph and paragraph line spacing are supported in AutoCAD 2007 and previous releases. See MTEXT Paragraph and Paragraph Line Spacing in Previous Releases.

Numbering
Displays the bullet and numbering menu.
Displays options for creating lists. (Not available for table cells.) The list is indented to align with the first selected paragraph.

- **Off** – when selected, removes letters, numbers, and bullets from selected text that has list formatting applied. Indentation is not changed.
- **Lettered** – applies list formatting that uses letters with periods for the items in the list. If the list has more items than the alphabet has letters, the sequence continues by using double letters.
- **Numbered** – applies list formatting that uses numbers with periods for the items in the list.
- **Bulleted** – applies list formatting that uses bullets for the items in the list.
- **Restart** – starts a new letter or number sequence in list formatting. If the selected items are in the middle of a list, unselected items below them also become part of the new list.
- **Continue** – adds the selected paragraphs to the last list above and continues the sequence. If list items rather than paragraphs are selected, unselected items below the selected items continue the sequence.
- **Allow Auto-list** – applies list formatting as you type. The following characters can be used as punctuation after letters and numbers and cannot be used as bullets: period (.), comma (,), close parenthesis ()), close angle bracket (>), close square bracket ([], and close curly bracket (}).
- **Use Tab Delimiter Only** – limits the Allow Auto-list and Allow Bullets and Lists options. List formatting is applied to text only when the space after the letter, number, or bullet character was created by TAB, not SPACEBAR. This option is selected by default.
- **Allow Bullets and Lists** – when this option is selected, list formatting is applied to
all plain text in the multiline text object that looks like a list. Text that meets the following criteria is considered to be a list. The line begins with (1) one or more letters or numbers or a symbol, followed by (2) punctuation after a letter or number, (3) a space created by pressing TAB, and (4) some text before the line is ended by ENTER or SHIFT+ENTER. When you clear the check mark, any list formatting in the multiline text object is removed and the items are converted to plain text. Allow Auto-list is turned off, and all the Bullets and Lists options are unavailable except Allow Bullets and Lists.

**Insert Field**
Displays the Field dialog box, where you can select a field to insert in the text. When the dialog box closes, the current value of the field is displayed in the text.

**Uppercase**
Changes the selected text to uppercase.

**Lowercase**
Changes the selected text to lowercase.

**Symbol**
Inserts a symbol or a nonbreaking space at the cursor position. You can also insert symbols manually. See Symbols and Special Characters.

Commonly used symbols are listed on the submenu, along with their control code or Unicode string. Click Other to display the Character Map dialog box, which contains the entire character set for each font available on your system. Select a character and click Select to place it in the Characters to Copy box. When you have selected all the characters that you want to use, click Copy to close the dialog box. In the editor, right-click and click Paste.

Symbols are not supported in vertical text.

**Oblique Angle**
Determines the forward or backward slant of the text. The angle represents the offset from 90 degrees. Entering a value between -85 and 85 makes the text oblique. A positive obliquing angle slants text to the right. A negative obliquing angle slants text to the left.
Tracking
Decreases or increases the space between the selected characters. The 1.0 setting is normal spacing. Set to more than 1.0 to increase spacing, and set to less than 1.0 to decrease spacing.

Width Factor
Widens or narrows the selected characters. The 1.0 setting represents the normal width of the letter in this font. You can increase the width (for example, use a width factor of 2 to double the width) or decrease the width (for example, use a width factor of 0.5 for half the width).

Additional Text Options

Insert Field
Displays the Field dialog box.

Symbol
Displays a list of available symbols. You can also select a Non-breaking space and open the Character Map for additional symbols.

Import Text
Displays the Select File dialog box (a standard file selection dialog box). Select any file that is in ASCII or RTF format. Imported text retains its original character formatting and style properties, but you can edit and format the imported text in the editor. After you select a text file to import, you can replace either selected text or all text, or append the inserted text to text selected within the text boundary. The file size for imported text is limited to 32 KB.

The editor automatically sets the text color to BYLAYER. When black characters are inserted and the background color is black, the editor automatically changes to white or the current color.

Note. A Microsoft Excel spreadsheet imported into a drawing is truncated at 72 rows unless the spreadsheet was created in Microsoft Office 2002 with Service Pack 2 installed. The same limitation applies when the drawing that contains the OLE object is opened on a system with an earlier version of Microsoft Office installed; the spreadsheet is truncated.
Paragraph Alignment
Sets alignment for the multiline text object. Top Left is the default setting. Spaces entered at the end of a line are included as part of the text and affect the justification of the line. Text is center-, left-, or right-justified with respect to the left and right text boundaries. Text is middle-, top-, or bottom-aligned with respect to the top and bottom text boundaries. See MTEXT command line for an illustration of the nine justification options.

Paragraph
Displays options for paragraph formatting. See the Paragraph dialog box.

Bullets and Lists
Displays the options for numbering lists.

Columns
Displays options for columns. See the Columns menu.

Find and Replace
Displays the Find and Replace dialog box.

Change Case
Changes the case of selected text. Options are Uppercase and Lowercase.

AutoCAPS
Converts all new and imported text to uppercase. AutoCAPS does not affect existing text. To change the case of existing text, select the text and right-click. Click Change Case.

Character Set
Displays a menu of code pages. Select a code page to apply it to the selected text.

Combine Paragraphs
Combines selected paragraphs into a single paragraph and replaces each paragraph return with a space.

Remove Formatting
Removes character formatting for selected characters, paragraph formatting for a selected paragraph, or all formatting from a selected paragraph.
Background Mask
Displays the Background Mask dialog box. (Not available for table cells.)

Editor Settings
Displays a list of options for the Text Formatting toolbar. See the Display Options menu.

Learn About MText
Displays the New Features Workshop, which contains an overview of the MText feature.

Display Options Menu
Changes the behavior of the Text Formatting toolbar and provides additional editing options. Options are specific to the Display Options menu and are not available on the Text Formatting toolbar.

Note. Some options may not be available depending on what you are editing.

Show Toolbar
Controls display of the Text Formatting toolbar. To restore display of the toolbar, right-click in the editor and click Option ➤ Show Toolbar.

Show Options
Expands the Text Formatting toolbar to show more options.

Show Rulers
Controls the display of the ruler.

Opaque Background
When selected, makes the background of the editor opaque. By default, the editor is transparent. (Not available for table cells.)

Text Highlight Color
Displays the AutoCAD generic Select Color dialog box. Specifies the highlight color when text is selected.
Working with a text in the AutoCAD program

Guidance for laboratory works for “Informatics and computer modeling basics” course /for foreign students of 2nd year studying by orientation 6.060102 «Architecture»/

Укладачі: Борис Петрович Бочаров,
Ігор Леонідович Яковицький,
Марія Юріївна Воєводіна,
Юрій Володимирович Левіков

План 2009, поз.521 М

<table>
<thead>
<tr>
<th>Підп. до друку 20.02.2009 р.</th>
<th>Формат 60х84 1/16. Папір офісний</th>
</tr>
</thead>
<tbody>
<tr>
<td>Друк на ризографі</td>
<td>Обсяг 0,9 обл. - вид. арк.</td>
</tr>
</tbody>
</table>

61002, м. Харків, ХНАМГ, вул. Революції, 12

Сектор оперативної поліграфії ЦНІТ ХНАМГ.
61002, м. Харків, вул. Революції, 12